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1. การจัดสภาพแวดล้อมการเรยีนรูข้องคอรส์ 
 

การจัดสภาพแวดล้อมการเรียนรู้ของคอร์ส เป็นการออกแบบและบริหารจัดการองค์ประกอบต่าง ๆ 
ของคอร์สบนระบบการเรียนรู้ เช่น โครงสร้างหลักสูตร เนื้อหา การประเมินผล การมีปฏิสัมพันธ์ระหว่างผู้สอน
และผู้เรียน และเทคโนโลยีที่ใช้สนับสนุนการเรียนรู้ ดังนั้น การจัดสภาพแวดล้อมของคอร์สบน SUT iLearn 
จึงเป็นขั้นตอนสำคัญที่ช่วยให้การเรียนการสอนออนไลน์เป็นระบบและมีประสิทธิภาพ ผู้สอนสามารถบริหาร
จัดการเนื้อหา กิจกรรม และเครื่องมือต่าง ๆ เพื่อให้ผู้เรียนเข้าถึงข้อมูลได้สะดวกและมีส่วนร่วมกับบทเรียน
มากขึ้น โดยเนื้อหานี้จะแนะนำวิธีการจัดการเนื้อหา อัปโหลดไฟล์ สร้างหน้าเนื้อหา เพิ่มวิดีโอ ลิงก์ภายนอก 
และใช้ฟอรั่มสนทนาในการเรียนการสอน ดังนี้ 

 
1.1 การต้ังค่ารายละเอียดคอรส์เพื่อแสดงผลต่อหน้า Course overview ของระบบ SUT 

iLearn 
1.1.1 เข้าสู่คอร์สรายวิชาของผู้สอนที่ได้สร้างไว้ ไปที่ เมนู “My course” จะปรากฏหน้าต่าง My 

course แสดงคอร์สรายวิชาที่สร้างไว้ ทำการ “คลิก” เข้ารายวิชาที่ต้องการ ดังตัวอย่าง คอร์ส “เรื่อง การ
สร้างสภาพแวดล้อมการเรียนรู้  Course บนระบบ SUT iLearn” ดังรูป  
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1.1.2 เมื่อเลือกเข้าคอร์สที่สร้างไว้จะแสดงหน้าต่างรายวิชา โดยมีแถบเมนูของคอร์ส (Course Menu 
Tabs) ให้เลือก แถบ “Settings” ดังรูป 

 
• Course full name: ตั้งชื่อคอร์ส  

• Course short name: ชื่อย่อของคอร์ส   

• Course category: หนว่ยงานที่สังกัด ตัวอย่าง ศูนย์นวัตกรรมและเทคโนโลยีการศึกษา (CEIT)  

• Course visibility: สถานะของคอร์ส Show เป็นการเปิดให้มองเห็น และ Hide เป็นการปิดคอร์ส
ไม่ให้ผู้เรียนมองเห็นหรือเข้าใช้งานได้ 

• Course start date และ Course end date: เป็นการเปิดช่วงเวลาในการอนุญาตการเข้าใช้งาน
คอร์สนั้น ๆ 

• Course ID number: รหัสเฉพาะของรายวิชา ที่ใช้ในการจัดการหลักสูตรภายในระบบ สามารถ
ใช้เพื่อเชื่อมโยงกับระบบภายนอก เช่น ฐานข้อมูลของมหาวิทยาลัย หรือระบบลงทะเบียนเรียน 
เป็นต้น เป็นค่าที่ไม่บังคับ 

• Description: รายละเอียดของคอร์สพอสังเขป เป็นส่วนสำคัญที่จะปรากฏในหน้า Course 
overview โดยการใส่รายละเอียดที่ Course summary 
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• Course image: ภาพปกของคอร์ส ที่แสดงอยู ่บนหน้า Dashboard และ Course overview 
ภาพปกนี้จะช่วยให้แยกแยะรายวิชาได้ง่ายขึ้น และทำให้หน้าหลักของระบบดูน่าสนใจขึ้น 

 
 

  นอกจากนั้นยังมีรายละเอียดสำคัญ ในส่วนของ “Course details” ประกอบด้วย 

• Objective: แสดงรายละเอียดคอร ์ส ที ่จะแสดงบนหน้า “Course overview” โดยระบุ
วัตถุประสงค์ของคอร์สและโครงสร้างเนื้อหาของคอร์ส 

• รูปแบบการเรียนการสอน: จะมีให้เลือก 3 รูป ได้แก่ การเรียนรู้จากผู้สอนออนไลน์ การเรียนรู้
ด้วยตนเอง และการเรียนรู้แบบผสมผสานระหว่างการเรียนรู้จากผู้สอนและเรียนรู้ด้วยตนเอง 

• ช่วงเวลาเรียน: ข้อมูลช่วงเวลาที่ใช้ในการเรียนรู้เนื้อหาคอร์ส 

• จำนวนชั่วโมงการเรียนรู้: เวลาที่ใช้ในการเรียนรู้เนื้อหาของคอร์ส 
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  เมื่อทำการตั้งค่าเรียบร้อยแล้วให้ทำการ “Save and display” เป็นการบันทึกค่าการตั้งค่าและ
แสดงผลในหน้า “Course overview” ดังรูป  

 
 

1.2 การจัดการเนื้อหาและกิจกรรมของคอรส์  
  ผู้สอนสามารถการจัดการเนื้อหา โดยการเพ่ิมเนื้อหา บทเรียน และกิจกรรมต่าง ๆ มีขั้นตอนดังนี้ 

1.2.1 การเข้าสู่คอร์สที่ได้สร้างไว้   
การเข้าสู่คอร์สที่ได้สร้างไว้  โดยการ “คลิก” เข้ารายวิชาที่ได้สร้างไว้ ดังตัวอย่าง คอร์ส  “เรื่อง 

การสร้างสภาพแวดล้อมการเรียนรู้  Course บนระบบ SUT iLearn” ดังรูป  
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ให้คลิกเข้าไปในคอร์สดังกล่าว เมื่อเข้าสู่คอร์สที่สร้างไว้ในฐานะสิทธิ์ ”ผู้สอน” จะปรากฏหน้าต่าง ดังรูป 
 

 
จากรูปหน้าต่างคอร์สบนระบบ SUT iLearn สามารถแบ่งออกเป็น 6 ส่วนหลัก ๆ  ดังนี้  
1) แถบเมน ูส ี เทาด ้านบน (Navigat ion Bar)  เป ็นแถบเมน ูหล ักของระบบ SUT iLearn 

ที่ช่วยให้ผู้ใช้เข้าถึงฟังก์ชันสำคัญได้สะดวก ประกอบด้วย 

• SUT iLearn: ปุ่มกลับไปยังหน้าแรกของระบบ 

• Home: เข้าสู่หน้าแรกของแพลตฟอร์ม   

• Dashboard: แสดงภาพรวมของคอร์สที่เรียนหรือสอนอยู่ 

• My Courses: รายการคอร์สทั้งหมดท่ีผู้ใช้ลงทะเบียน  

• Site Administration: เมนูการตั้งค่าระบบ (สำหรับผู้ดูแลระบบ) 

• ไอคอนแจ้งเตือน (กระดิ่ง): แสดงการแจ้งเตือนเกี่ยวกับกิจกรรมในคอร์ส 

• ไอคอนโปรไฟล์ผู้ใช้: ใช้เข้าถึงข้อมูลบัญชีของผู้ใช้ 
2) ชื่อคอร์ส (Course Title) 

• แสดงชื่อของคอร์สที่กำลังเปิดอยู่ ทำให้ผู้สอนและผู้เรียนทราบว่ากำลังอยู่ในรายวิชาใด 
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3) แถบเมนูของคอร์ส (Course Menu Tabs) อยู่ใต้ชื่อคอร์ส ใช้สำหรับเข้าถึงการตั้งค่าต่าง ๆ ของ
คอร์ส ประกอบด้วย 

• Course: หน้าแสดงเนื้อหาและโครงสร้างของคอร์ส   

• Settings: ตั้งค่าคอร์ส เช่น ชือ่คอร์ส และรูปแบบการแสดงผล 

• Participants: ดูรายชื่อและจัดการผู้เข้าร่วมคอร์ส 

• Grades: แสดงผลการเรียนและคะแนนของผู้เรียน 

• Reports: รายงานเกี่ยวกับกิจกรรมของผู้เรียน 

• More: ตัวเลือกเพ่ิมเติม เช่น การนำเข้าคอร์ส หรือบันทึกข้อมูล 
4) พื้นที่เนื้อหาคอร์ส (Course Content Area) เป็นส่วนหลักของหน้าต่างคอร์ส แสดงเนื้อหาและ

กิจกรรมการเรียนรู้ แบ่งเป็น 

• General (ส่วนทั่วไป): ใช้สำหรับประกาศ และเนื้อหาสำคัญของคอร์ส เช่น Announcements 
เป็นต้น 

• Topic 1 (และหัวข้ออ่ืน ๆ): ส่วนที่ใช้แบ่งเนื้อหาออกเป็นหัวข้อตามลำดับ 
5) ปุ่ม Edit Mode" (โหมดแก้ไขคอร์ส) 

• ใช้สำหรับเปิด/ปิดโหมดแก้ไขคอร์ส เมื่อเปิดใช้งาน ผู้สอนสามารถเพ่ิมหรือแก้ไขเนื้อหาของคอร์ส 
6) ปุ่มควบคุมเพ่ิมเติม (Help & Collapse Buttons) 

• ปุ่ม “Collapse all”: ใช้ย่อหวัข้อทั้งหมดเพ่ือให้หน้าต่างดูกะทัดรัด 

• ไอคอนเครื่องหมายคำถาม (?): ปุ่มช่วยเหลือสำหรับดูคู่มือการใช้งานของระบบ 
 

1.2.2 การสร้างหัวข้อ (Section) และโครงสร้างคอร์ส  
การสร้างหัวข้อ (Section) และโครงสร้างคอร์ส โดยการเปิดโหมดการจัดการแก้ไขคอร์ส โดย

ไปที่มุมบนขวามือ ปุ่ม “Edit Mode” (โหมดแก้ไขคอร์ส) เพื่อเปิดการแก้ไข ในหน้าคอร์สนั้น ๆ จะปรากฏ
หน้าต่างพร้อมสำหรับทำการแก้ไขคอร์ส จะสังเกตได้ว่ามี “Icon รูปดินสอ” สำหรับปรับแก้ไข และจะมีปุ่ม “+ 
Add topic” ปรากฏขึ้น เมื่อกดเพ่ิมจะปรากฏ หัวข้อ (Section) ใหม่ข้ึนมา โดยผู้สอนสามารถแบ่งเนื้อหาตาม
หัวข้อ หรือแยกเป็นบทเรียน หรือสัปดาห์การเรียนรู้ได้ ดังรูป 
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1.2.3 การอัปโหลดไฟล์เอกสาร (PDF, PPT, Word)  
การอัปโหลดไฟล์เอกสาร (PDF, PPT, Word) โดยการเปิดโหมดการจัดการแก้ไขคอร์ส โดยไป

ที่มุมบนขวามือ ปุ่ม “Edit Mode” และจะปรากฏหน้าต่างพร้อมสำหรับทำการแก้ไขคอร์ส จะสังเกตได้ว่ามี 
“Icon รูปดินสอ” สำหรับแก้ไขชื่อได้ โดยมี ปุ่ม “+ Add an activity or resource” สามารถเพิ่มกิจกรรม
ต่าง ๆ ได ้ดังรูป 

 
 

• การอัปโหลดไฟล์เอกสาร (PDF, PPT, Word)  ให้เลือกกิจกรรม “File” ดังรูป 
 

                   

หัวข้อ 
(Sect
ion)หั
วข้อ 
(Sect
ion) 

หัวข้อ 
(Sect
ion)หั
วข้อ 
(Sect
ion) 
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เมื ่อปรากฏหน้าต ่าง “Adding a new File” ให้ทำการใส่รายละเอียดที ่จำเป ็นต้องใส่ในส ่วน 
“General” ดังนี้  

• General -> Name: ชื่อไฟล์ที่จะนำเข้า  

• General -> Description: ใส่รายละเอียดเพ่ิมเติมเกี่ยวกับไฟล์ได้  

•  General -> Select files: เลือกไฟล์โดยสามารถอัปโหลดจากเครื่องคอมพิวเตอร์ได้ เมื่อทำการ
อัปโหลดแล้วให้เลือก ปุ่ม “Upload this file” จะปรากฏไฟล์เอกสารบนคอร์สเรียน  
  
 โดยตัวอย่างจะเป็นไฟล์ PDF ซึ่งสามารถนำไฟล์ประเภท PPT และ Word ขึ้นบนคอร์สเรียนได้ด้วยวิธี
เดียวกัน ดังรูป 
                                                         

  
 

1.2.4 การนำไฟล์วิดีโอจาก YouTube หรือไฟล์วิดีโอภายในระบบ  
การนำไฟล์วิดีโอจาก YouTube หรือไฟล์วิดีโอภายในระบบ เนื่องจากระบบเรียนออนไลน์ไม่ได้

เป็น Server สำหรับการ Streaming Video อาจจะทำให้เกิดปัญหาในการเปิดวิดีโอเล่น มีการกระตุก และ
แสดงผลไม่ต่อเนื่อง จึงแนะนำให้มีการนำเข้าลิงก์ไฟล์วิดีโอจาก YouTube โดยสามารถนำเข้าระบบได้จาก
หลายกิจกรรม เช่น กิจกรรม Page และ กิจกรรม Super Video เป็นต้น ดังรูป 
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                         1)  2)  
 

วิธีการนำไฟล์วิดีโอจาก YouTube หรือไฟล์วิดีโอภายในระบบ มีรายละเอียด ดังนี้ 
1) การใช้ กิจกรรม “Page”  เพื่อนำไฟล์วิดีโอแสดงบนระบบ โดยเมื่อเลือกกิจกรรม “Page” จะ

ปรากฏหน้าต่าง “Adding a new Page to … (ชื่อ Section)” ดังรูป  
 

 
 

รายละเอียดที่จำเป็นต้องใส่ในส่วน “General” และ “Content” ดังนี้  

• General -> Name: ชื่อกิจกรรม (จำเป็นต้องใส่) 

• General -> Description: รายละเอียดกิจกรรม (ไม่จำเป็นต้องใส่) 



- 10 - 
 

ศูนย์นวตักรรมและเทคโนโลยีการศึกษา  มหาวิทยาลัยเทคโนโลยีสุรนาร ี

• Content -> Page Content: หน้าเนื ้อหา (จำเป็นต้องใส่) โดยการไปเลือก Copy ลิงก์แบบฝัง 
(Embed) จาก YouTube ในวิดีโอที่ต้องการ (ไปที่ลิงก์ไฟล์วิดีโอ -> เลือก Share -> เลือก Embed) ดังรูป  
 

                    
 

 
 

หลังจากนั้นทำการ Copy Code Embed Video แล้วกลับมาที่หน้ากิจกรรม “Page -> ส่วน Content 
-> Page content -> View -> Source code” เม ื ่อปรากฏหน้าต ่าง  “Source code” ให ้วาง  Code 
Embed Video ในช่องว่างและระบบจะแสดงผลหน้าวิดีโอ ดังกล่าว และทำการเลือกปุ่ม “Save and return 
to course” หรือ “Save and Display” ดังรูป 
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เมื่อทำการ Save จะแสดงผลในหน้าคอร์สเป็นหัวข้อกิจกรรม และคลิกหัวข้อกิจกรรมเพ่ือเข้าดู Video 
ได ้ดังรูป  
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 กรณีต้องการให้แสดง Video ในหน้าคอร์สให้ใส ่ Code Embed Video ในส่วน “General -> 
Description” โดยวิธีการเช่นเดียวกับการใส่ส่วนของ ส่วน “Content -> Page content” และติ๊กกล่อง 
“Display description on course page” จะแสดงผลดังรูป 

 

     
 

2) การใช้ กิจกรรม “Super Video” เพื่อนำไฟล์วิดีโอแสดงบนระบบ โดยเมื่อเลือกกิจกรรม “Super 
Video” จะปรากฏหน้าต่าง “Adding a new Super Video to … (ชื่อ Section)” ดังรูป 
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รายละเอียดที่จำเป็นต้องใส่ในส่วน “General”, “Grade” และ ส่วน “Completion conditions” ดังนี้ 

• General -> Name: ชื่อกิจกรรม (จำเป็นต้องใส่) 

• General -> Video Source: เลือก แหล่งที่มาของ Video แนะนำเลือก “Video from YouTube” 
จะปรากฎช่องให้ใส่ลิงก์ “Video from YouTube” โดยสามารถ Copy ลิงก์ Video YouTube ที่ต้องการมา
ใส่ในช่องว่างดังกล่าวได้เลย และสามารถกำหนดการแสดงตัวควบคุมของเครื่องเล่นสำหรับ YouTube และ 
Vimeo และ/หรือ การเลือกเล่นวิดีโอโดยอัตโนมัติ ดังรูป 

          

        
 

• Grade -> คะแนน โดยสามารถกำหนด การให้คะแนนโดนกำหนดตามร้อยละในการดู Video 
หรือไม่กำหนดการให้คะแนนก็สามารถเลือก “No grades” ได้ และสามารถกำหนด เกรดที่จะผ่านในการทำ
กิจกรรมได้ ดังรูป 

 
 

• Completion conditions -> การกำหนดเงื่อนไขการทำกิจกรรมให้สำเร็จ โดยสามารถกำหนดร้อย
ละของวิดีโอที่ต้องการให้ผู้เรียนดูได้เพ่ือระบบจะคำนวณกิจกรรมดูวิดีโอนั้นเมื่อผ่านร้อยละที่กำหนด ถึงจะคิด
ผลเป็นการทำกิจกรรมที่สำเร็จ และการคำนวณเป็นร้อยละของคะแนนตามการดูวิดีโอนั้น ๆ ได้ ดังรูป 
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  เมื่อตั้งค่าต่าง ๆ เรียบร้อยแล้ว ให้ทำการ Save โดยการเลือกปุ่ม “Save and return to course” 
หรือ “Save and Display” จะแสดงผลในหน้าคอร์ส ดังรูป 
 

 
 

เมื่อคลิกเข้าไปกิจกรรมจะแสดงวิดีโอ พร้อมแถมแสดงผลร้อยละของการดู และข้อกำหนดการทำ
กิจกรรมในการเข้าดูวิดีโอนั้น ๆ ดังรูป 

 
 

1.2.5 การใช้ “Text and media” และ “URL” เพ่ือลิงก์ไปยังแหล่งข้อมูลเพ่ิมเติม  
การใช้ กิจกรรม “Text and media” และ กิจกรรม “URL” เพ่ือลิงก์ไปยังแหล่งข้อมูลเพิ่มเติม

หรือการเพิ่มเนื้อหาบนคอร์ส โดยเมื่อเปิดโหมดการจัดการแก้ไขคอร์ส โดยไปที่มุมบนขวามือ ปุ่ม  “Edit 
Mode” และ จะปรากฏหน้าต่างพร้อมสำหรับทำการแก้ไขคอร์ส จะสังเกตได้ว่ามี Icon รูปดินสอ สำหรับการ
ปรับแก้ไขมีปุ่ม “+ Add an activity or resource” สามารถเลือกเพ่ิมกิจกรรมได้ ระบบจะแสดง Icon ดังรูป 

     1)       2)  
 

วิธีการใช้งานกิจกรรม “Text and media” และ กิจกรรม “URL” มีรายละเอียด ดังนี้ 
1) การใช้กิจกรรม “Text and media”  

กิจกรรม "Text and media area" เป็นเครื่องมือที่ช่วยให้ผู้สอนสามารถแทรกข้อความ รูปภาพ 
สื่อมัลติมีเดีย หรือโค้ดต่าง ๆ ลงในหน้ารายวิชาระหว่างทรัพยากรหรือกิจกรรมอ่ืน ๆ เพื่อปรับปรุงการนำเสนอ
เนื้อหาและเพิ่มความน่าสนใจให้กับรายวิชา โดยเมื่อเลือกกิจกรรม “Text and media” จะปรากฏหน้าต่าง 
“Adding a new Text and media area to… (ชื่อ Section)” ดังรูป 
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รายละเอียดที่จำเป็นต้องใส่ในส่วน General ดังนี ้

• General -> Title in course index: ช ื ่อท ี ่จะแสดงในสารบ ัญของรายว ิชา (Course Index) 
ด้านซ้ายของหน้าจอ ซึ่งช่วยให้ผู้เรียนสามารถนำทางไปยังเนื้อหาต่าง ๆ ได้ง่ายข้ึน 

• General -> Text: ข้อความที่ผู ้สอนสามารถเพิ ่มลงไปในหน้ารายวิชา  เพื่อให้ข้อมูลเพิ่มเติมแก่
ผู้เรียน โดยสามารถเป็น ตัวอักษรธรรมดา ข้อความที่มีการจัดรูปแบบ (Rich Text) หัวข้อ คำอธิบาย หรือ
แม้แต่โค้ด HTML ได้ นอกจากนี้ยังสามารถใส่ลิงก์ Video จาก YouTube ได้ โดยขั้นตอนเช่นเดียวกับวิธี 
Content -> Page Content ที่ได้กล่าวไว้ก่อนหน้า 

เมื่อตั้งค่าต่าง ๆ เรียบร้อยแล้ว ให้ทำการ Save โดยการเลือกปุ่ม “Save and return to course” จะ
แสดงผลในหน้าคอร์ส ดังรูป 

 
 

2) การใช้กิจกรรม “URL”  
กิจกรรม URL บน Moodle ใช้สำหรับ แนบลิงก์ไปยังแหล่งข้อมูลภายนอก เช่น เว็บไซต์  วิดีโอ 

ไฟล์บนคลาวด์ หรือเนื้อหาออนไลน์อื่น ๆ เพื่อให้ผู้เรียนเข้าถึงข้อมูลที่เกี่ยวข้องได้สะดวกขึ้น โดยเมื่อเลือก
กิจกรรม จะปรากฏหน้าต่าง “Adding a new URL to… (ชื่อ Section)” ดังรูป 
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รายละเอียดที่จำเป็นต้องใส่ในส่วน General ดังนี ้

• General -> Name: ชื่อกิจกรรม หรือหัวข้อเนื้อหาที่ต้องการลิงก์ 

• General -> External URL: สำหรับใส่ลิงก์ ที่ต้องการให้ผู้เรียนคลิกและเข้าถึง 

• General -> Description: รายละเอียดของกิจกรรม หรือหัวข้อเนื้อหาที่ต้องการลิงก์ (ไม่จำเป็นต้อง
ใส่) 

ตัวอย่างการใส่ข้อมูล ดังรูป 
 

 
 

เมื่อตั้งค่าต่าง ๆ เรียบร้อยแล้ว ให้ทำการ Save โดยการเลือกปุ่ม “Save and return to course” 
หรือ “Save and Display” จะแสดงผลในหน้าคอร์ส ดังรูป 

 
 

1.3 การสรา้งกิจกรรมการเรยีนรู ้บนระบบ SUT iLearn 
  การสร้างกิจกรรมการเรียนรู้เป็นกระบวนการที่ออกแบบมาเพื่อให้ผู้เรียนมีส่วนร่วมในการเรียนรู้  ผ่าน
การกระทำต่าง ๆ เช่น การอภิปราย การทำแบบฝึกหัด การทดลอง หรือการทำโครงงาน โดยมีเป้าหมาย
เพื่อให้ผู้เรียน เกิดความเข้าใจ พัฒนาแนวคิด ฝึกปฏิบัติและสามารถนำความรู้ไปใช้ได้จริง  ผ่านกิจกรรมการ
เรียนรู ้ที ่หลากหลาย เช่น ฟอรัม (Forum) การตั ้งค่าห้องสนทนาและการอภิปราย การมอบหมายงาน 
(Assignment) และแบบสำรวจ (Survey & Feedback) เป็นต้น 
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1.3.1 ฟอรัม (Forum) การตั้งค่าห้องสนทนาและการอภิปราย  

ฟอรัม (Forum) การตั้งค่าห้องสนทนาและการอภิปราย เป็นเครื่องมือสำหรับการสนทนาและ
อภิปรายออนไลน์ ซึ่งช่วยให้ผู้สอนและผู้เรียนสามารถแลกเปลี่ยนความคิดเห็นและแบ่งปันข้อมูลกันได้ ฟอรัม
สามารถใช้สำหรับการอภิปรายทั่วไป การถาม-ตอบ และการทำงานกลุ่ม ภายในฟอรัม ผู้เรียนสามารถสร้าง
กระทู้ (หัวข้อสนทนา) และตอบกลับความคิดเห็นของเพ่ือนร่วมเรียนได้ นอกจากนี้ยังสามารถแนบไฟล์หรือส่ง
คำถามเพื่อขอคำแนะนำจากผู้สอนและเพื่อน ๆ ได้อย่างสะดวก โดยฟอรัมมีหลายประเภทที่สามารถตั้งค่าได้
ตามวัตถุประสงค์การใช้งาน ได้แก่ 

• Standard forum for general use: ฟอรัมเปิดทั่วไปทุกคนสามารถสร้างกระทู้ใหม่และตอบกลับ 

• Single simple discussion: ฟอรัมที่มีเพียงหนึ่งกระทู้ และทุกคนสามารถตอบกลับได้ 

• Each person posts one discussion: นักศึกษาแต่ละคนสามารถสร้างกระทู้ของตัวเองได้หนึ่ง
กระทู้เท่านั้น 

• Q and A forum: ผู้เรียนต้องโพสต์คำถามของตัวเองก่อน จึงจะสามารถเห็นคำตอบของผู้อื่นได้ 

• Standard forum displayed in a blog-like format: ฟอรัมที่แสดงเนื้อหาแบบบล็อก 
 เมื ่อเล ือกเพิ ่มกิจกรรม ฟอรัม (Forum) จะปรากฏหน้าต่าง “Adding a new Forum to… (ชื่อ 
Section)” ดังรูป 
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รายละเอียดที่จำเป็นต้องใส่ในส่วน General ดังนี ้

• General -> Forum name: ชื่อกิจกรรมกระดานสนทนานั้น ๆ (จำเป็นต้องใส่) 

• General -> Description: รายละเอียดของกิจกรรมกระดานสนทนานั้น ๆ (ไม่จำเป็นต้องใส่) 

• Forum type: เลือกตามประเภทของ Forum ตามที่ต้องการ  
 

ตัวอย่างการสร้าง Forum และจะปรากฏบนหน้าคอร์ส ดังรูป 

 
 เมื่อคลิกเข้าไปที่กิจกรรม ผู้เรียนหรือผู้สอนสามารถไปสร้างหัวข้อในการสนทนาได้ โดยเลือกปุ่ม 
“Add discussion topic” ใส่รายละเอียดชื่อหัวข้อและข้อความที่ต้องการอภิปราย เมื่อทำการกดปุ่ม “Post 
to Forum” จะแสดงหัวข้อการสนทนา รายละเอียดผู้โพส และจำนวนการตอบ โดยสามารถคลิกเข้าไปตอบ
หรือสนทนาได้ หรือผู้โพสสามารถจัดการลบหรือแก้ไชโพสนั้น ๆ ได้ ดังรูป 
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1.3.2 การมอบหมายงาน (Assignment)  
  การมอบหมายงาน (Assignment) เป็นกิจกรรมที่ผู้สอนสามารถกำหนดให้ผู้เรียน ส่งงาน ผ่าน
ระบบออนไลน์ ซึ่งช่วยให้การส่งงานมีความสะดวกและสามารถ ตรวจสอบและให้คะแนน ได้ โดยผู้เรียน
สามารถส่งงานได้ในรูปแบบต่างๆ เช่น ไฟล์เอกสาร รูปภาพ วิดีโอ ข้อความ และไฟล์เสียงได้ เมื่อเลือกเพ่ิม
กิจกรรม “การมอบหมายงาน (Assignment)” จะปรากฏหน้าต่าง “Adding a new Assignment to…      
(ชื่อ Section)” ดังรูป 
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รายละเอียดที่จำเป็นต้องใส่ในส่วน General, Availability, Submission types และ Grade ดังนี้ 

• General -> Assignment name: ชื่อกิจกรรมการบ้านหรืองานที่มอบหมายงาน (จำเป็นต้องใส่) 

• General -> Description: รายละเอียดกิจกรรมการบ้านหรืองานที่มอบหมายงาน 

• General -> Activity instructions: คำแนะนำในการทำกิจกรรมหมายถึง ข้อความที่ผู้สอนสามารถ
ให้รายละเอียดหรือคำแนะนำเกี่ยวกับการมอบหมายงานนั้น ๆ ซึ่งช่วยให้ผู้เรียนเข้าใจวัตถุประสงค์และวิธีการ
ทำงานได้ชัดเจนมากข้ึน  

• General -> Additional files: ไฟล์ที่ผู้สอนสามารถแนบให้กับผู้เรียนเพ่ือใช้เป็นข้อมูลอ้างอิงในการ
ทำงานหรือการมอบหมายงานต่าง ๆ โดยไฟล์ที่นำเข้าระบบจะปรากฏในหน้ากิจกรรมของการมอบหมายงาน
เพื่อให้ผู้เรียนสามารถดาวน์โหลดและใช้งานได้ ซึ่งระบบสามารถรองรับหลายประเภท เช่น PDF Word ไฟล์
วิดีโอ เสียง เป็นต้น 

• Availability -> Allow submissions from: การกำหนดตั้งวันทีแ่ละเวลาที่จะอนุญาตให้ผู้เรียนเริ่ม
ส่งงาน 

• Availability -> Due date: กำหนด วันและเวลาที่ผู้เรียนต้องส่งงานให้เสร็จสิ้นหรือวันครบกำหนด
ส่งงาน 

• Availability -> Cut-off date: กำหนดตั้งวันและเวลา ที่การส่งงานจะปิดลง โดยหากผู้เรียนส่งงาน
หลังจากเวลานี้ จะถูกนับว่าเป็นการส่งงานล่าช้า 

• Submission types -> Submission types: เลือกประเภทการส่งงานเป็น Online text และ/ 
หรือ File submissions 

• Submission types -> Word limit -> Enable: กรณีเลือกเป็น Online text สามารถกำหนดการ
จำกัดจำนวนคำได้ 

• Submission types -> Maximum number of uploaded files: กรณีเลือกการส่งงานในรูปแบบ
ไฟล์สามารถกำหนดจำนวนไฟล์ที่จะให้ส่งได้ 

• Submission types -> Maximum submission size: กำหนดขนาดไซต์ของไฟล์งานที่จะส่ง  

• Submission types -> Accepted file types: สามารถระบุประเภทไฟล์ที ่ต ้องการให้ส่ง  โดย
สามารถเลือกปุ่ม “Choose” เช่น .doc, .docx, .epub, .gdoc, .mp3, และ .m4a เป็นต้น 

• Grade -> Grade: กำหนดประเภทการให้คะแนน (Type) ประกอบด้วย 3 ประเภท ได้แก่ 1) None 
(ไม่มีคะแนน) 2) Scale (ระดับคะแนน) เช่น ผ่าน/ไม่ผ่าน ดี/ปานกลาง/แย่ เป็นต้น และ 3) Point (ให้คะแนน
เป็นตัวเลข) และการกำหนดคะแนนสูงสุด (Maximum grade) เช่น 100 คะแนน 10 คะแนน เป็นต้น 

• Grade -> Grading method: เลือกวิธีการให้คะแนน มี 3 รูปแบบหลัก ได้แก่ 1) การให้คะแนน
โดยตรง (Simple direct grading) คือ ผู้สอนป้อนคะแนนที่เหมาะสม เช่น 80/100, 18/20 เป็นต้น 2) การให้
คะแนนตามเกณฑ์มาตรฐาน (Rubric) คือการให้คะแนนที่มีเกณฑ์การประเมินชัดเจน เช่น เนื้อหา (Content) 



- 22 - 
 

ศูนย์นวตักรรมและเทคโนโลยีการศึกษา  มหาวิทยาลัยเทคโนโลยีสุรนาร ี

– 10 คะแนน โครงสร้าง (Structure) – 5 คะแนน การนำเสนอ (Presentation) – 5 คะแนน เป็นต้น 3) คู่มือ
ให้คะแนน (Marking guide) คือการให้คะแนนโดยมีคู่มือที่ผู้สอนสามารถใส่คำอธิบายเพิ่มเติมเกี่ยวกับวิธีให้
คะแนนแต่ละส่วนได ้

• Grade -> Grade to pass: การกำหนดคะแนนขั้นต่ำที่ถือว่า “ผ่าน” เช่น หากคะแนนเต็ม 100 
คะแนน อาจกำหนดให้ 50 คะแนนขึ้นไปถือว่าผ่าน เป็นต้น 

• Grade -> Anonymous submissions: การส่งแบบไม่เปิดเผยตัวตน 

• Grade -> Hide grader identity from students: ซ่อนตัวตนของผู้ให้คะแนนจากผู้เรียนกรณีมี
ผู้สอนหลายคน 

• Grade -> Use marking workflow: ใช้กระบวนการตรวจงานแบบเป็นขั้นตอน เหมาะสำหรับกรณี
ที่มีผู้ตรวจหลายคนและต้องการให้คะแนนผ่านหลายขั้นตอนก่อนเผยแพร่ 

 
เมื่อตั้งค่าต่าง ๆ เรียบร้อยแล้ว ให้ทำการ Save โดยการเลือกปุ่ม “Save and return to course” 

หรือ “Save and Display” จะแสดงผลในหน้าคอร์ส ดังรูป 

 
 

 กรณีผู้เรียนเข้าส่งงานจะปรากฏรายละเอียดของกิจกรรม มอบหมายงาน และปุ่ม “Add submission” 
ซึ่งเป็นปุ่มกดส่งงาน จะปรากฏหน้าต่างส่งงาน หรือหน้า “Add submission” ผู้เรียนสามารถคลิกเพ่ิมไฟล์หรือ
กดลูกศรชี้ลงได้ จะเข้าถึงไฟล์งานบนอุปกรณ์ของผู้เรียน ทำการเลือกและกดปุ่ม “Upload this file” และ
เลือก ปุ่ม “Save change” ดังรูป 
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1.3.3 การทำแบบสอบถาม (Feedback) 
การทำแบบสอบถาม (Feedback) เป็นเครื่องมือที่ช่วยสร้างแบบสอบถามเพื่อเก็บความคิดเห็น

การประเมินผลหรือข้อมูลจากผู้เรียน โดยสามารถออกแบบคำถามเองได้ รองรับคำถามหลายรูปแบบ และ
สามารถตั้งค่าให้ไม่ระบุตัวตนได้ เมื่อเลือกเพิ่มกิจกรรม “การทำแบบสอบถาม (Feedback)” จะปรากฏ
หน้าต่าง “Adding a new Feedback to… (ชื่อ Section)” ดังรูป 

 
 

รายละเอียดที่จำเป็นต้องใส่ในส่วน General, Availability, Question and submission settings 
และ After submission ดังนี้ 

• General -> Name: ชื่อกิจกรรมการทำแบบสอบถาม (Feedback)  

• General -> Description: รายละเอียดกิจกรรมการทำแบบสอบถาม (Feedback) 

• General -> Availability: การกำหนดเวลาในการให้ผู้เรียนเข้าทำแบบสอบถาม 



- 24 - 
 

ศูนย์นวตักรรมและเทคโนโลยีการศึกษา  มหาวิทยาลัยเทคโนโลยีสุรนาร ี

• Availability -> Allow answers from: การกำหนดตั้งวันที่และเวลาที่จะอนุญาตให้ผู้เรียนเริ่มเข้า
ทำกิจกรรมแบบสอบถาม (Feedback) 

• Availability -> Allow answers to: กำหนดวันและเวลาที่สุดท้ายที่เปิดให้ผู้เรียนเข้าทำกิจกรรม
แบบสอบถาม (Feedback)  

• Question and submission settings -> Record user names: เป็นการกำหนดค่าคำถามและ
การตอบ หากต้องการแสดงชื่อผู้ตอบ ให้เลือก “User’s name will be logged and show with answers” 
และหากไม่ต้องการแสดงชื่อผู้ตอบให้เลือก “Anonymous” 

• Question and submission settings -> Allow multiple submissions: หากต้องการให้ผู้เรียน
ตอบหลายครั้งให้เลือก “Yes” แต่หากต้องการให้ผู้เรียนตอบครั้งเดียวให้เลือก “No” 

• Question and submission settings -> Enable notification of submissions: การกำหนดให้
มีการแจ้งเตือนผู้สอนเมื่อมีการส่งคำตอบ ให้เลือก “Yes” แต่หากไม่ต้องการให้แจ้งเตือนให้เลือก “No” 

• Question and submission settings -> Auto number questions: การกำหนดหมายเลข
คำถามแบบอัตโนมัติ ให้เลือก “Yes” แต่หากไม่ต้องการให้แสดงลำดับเลขคำถามให้เลือก “No” 

• After submission -> Show analysis page: การกำหนดการแสดงผลการตอบหล ังจากส่ง
แบบสอบถามแล้ว ผู้เรียนสามารถดูผลสรุปคำตอบทั้งหมดในรูปแบบกราฟหรือสถิติ 

• After submission -> Show analysis page: การกำหนดให ้แสดงข ้อความเม ื ่ อผ ู ้ เร ี ยนส่ ง
แบบสอบถาม (Feedback) แล้ว ให้เลือก “Yes” แต่หากไม่ต้องการให้แสดงข้อความให้เลือก “No” 

• After submission -> Completion message: กล่องใส่ข้อความเมื ่อผู ้เร ียนส่งแบบสอบถาม 
(Feedback) แล้ว 
 เมื่อตั้งค่าต่าง ๆ เรียบร้อยแล้ว ให้ทำการ Save โดยการเลือกปุ่ม “Save and return to course” 
หรือ “Save and Display” จะแสดงผลในหน้าคอร์ส ดังรูป 
 

 
 

เมื่อคลิกเข้ากิจกรรมที่สร้างขึ้น จะเป็นหน้าต่าง การจัดการ “การทำแบบสอบถาม (Feedback)” โดย
สามารถเพ่ิมข้อคำถามได้ ดังรูป  
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 สร้างข้อคำถามของแบบสอบถาม โดยการเลือกปุ ่ม Edit questions จะปรากฏหน้าต่างเพ่ิม        
ข้อคำถาม โดยเลือกประเภทคำถามตามความเหมาะสม ดังรูป  
 

 
 

ตารางประเภทคำถามในกิจกรรม การทำแบบสอบถาม (Feedback) 
ประเภทคำถาม คำอธิบาย 
Add a page break ใช้แบ่งหน้าแบบสอบถาม 
Captcha ระบบป้องกันบอท (Bot Protection System) ที่ใช้ทดสอบว่า ผู้ใช้เป็นมนุษย์

จริงหรือไม่ 
Information ข้อมูลของแบบสอบถาม 
Longer text answer คำตอบแบบยาว (ไม่มีการจำกัดจำนวนคำ) 
Multiple choice  คำตอบแบบตวัเลือกเดียว (เลือกได้เพียง 1 ข้อ) 
Multiple choice (rated) ประเภทของคำถามที่ให้ผู้ตอบเลือก 1 ตัวเลือก จากหลายตัวเลือกที่มี คะแนน

กำกับ อยู่แต่ละคำตอบ 
Numeric answer คำตอบที่เป็นตัวเลข 
Short text answer คำตอบแบบขอ้ความสั้น (จำกัดจำนวนอักขระ) 
Numeric answer คำตอบที่เป็นตัวเลข 
Multiple choice  คำตอบแบบตวัเลือกเดียว (เลือกได้เพียง 1 ข้อ) 
Text and media area ป้ายขอ้ความหรอืพื้นที่ใส่สื่อต่าง ๆ 

 

ตัวอย่างการสร้างแบบสอบถาม แบบ Multiple choice (rated) โดยการเลือกปุ่ม Add question → 
Multiple choice (rated) และกำหนดค่าที่สำคัญ ดังนี้ 
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• Multiple choice (rated) -> Question: รายละเอียดข้อคำถาม 

• Multiple choice (rated) -> Multiple choice type: เลือกประเภทการแสดงผลรูปแบบ 
Multiple choice – single answer หรือ Multiple choice single answer allowed (drop-
down menu) 

• Multiple choice (rated) -> Adjustment: เลือกแบบแนวตั้ง (Vertical) หรือแนวนอน 
(Horizotal) 

• Multiple choice (rated) -> Hide the "Not selected" option: เลือกการแสดงผล ยังไม่
เลือกหรือไม่ หากใช่ให้เลือก “Yes” แต่หากไม่ต้องการให้แสดงให้เลือก “No” 

• Multiple choice (rated) -> Omit empty submits in analysis: การละเว้นข้อมูลจากการ
วิเคราะห์ผลที่ผู้ตอบไม่กรอกข้อมูลในแบบสอบถาม หรือ ผู้ตอบทิ้งช่องคำถามที่ว่างเปล่าไว้ 

• Multiple choice (rated) -> Multiple choice values: กำหนดตัวเลือกที่เป็นคะแนน เช่น  
1 หมายถึง พอใจน้อยที่สุด 
2 หมายถึง พอใจน้อย  
3 หมายถึง ปานกลาง 
4 หมายถึง พอใจมาก 
5 หมายถึง พอใจมากที่สุด 
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เมื่อใส่ข้อคำถามเสร็จสิ้นสามารถดูอย่าง โดยการเลือกกด Preview ได้จะเห็นเป็นหน้าแบบสอบถามที่
สร้างข้ึนในมุมมองของผู้เรียนที่จะเข้ามาตอบแบบสอบถามดังรูป 
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เมื่อผู้เรียนเข้ามาทำกิจกรรมจะเห็นปุ่ม Answer the questions ให้เข้าสู่หน้าคำถามของแบบสอบถาม
ได้ เพ่ือเข้าตอบแบบสอบถามนั้น ๆ 

 
 
เมื ่อมีการตอบแบบสอบถามเรียบร้อยแล้ว ผู ้สอนสามารถติดตามผลการตอบได้ โดยเลือก Tab 

Analysis และจะแสดงผลการตอบแบบสอบถามนั้น ๆ ดังรูป 
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2. การจัดท า Certificate บนระบบ SUT iLearn 
 
การจัดทำ Certificate บนระบบ SUT iLearn ให้ผู้เรียนที่ผ่านการเรียนคอร์สออนไลน์หรือผ่านการทำ

แบบทดสอบในคอร ์ส โดยใช ้  ก ิจกรรม “Custom Certificate” เม ื ่อเล ือกเพ ิ ่มก ิจกรรม “Custom 
Certificate” จะปรากฏหน้าต่าง “Adding a Custom certificate to… (ชื่อ Section)” ดังรูป 

 

                                
 
 

การตั้งค่า “ประกาศนียบัตร (Certificate)” มี 2 ขั้นตอนในการสร้าง กิจกรรม “ประกาศนียบัตร 
(Certificate)”  

ขั้นตอนที่ 1 เริ่มการสร้างกิจกรรม “ประกาศนียบัตร (Certificate)”  
  เริ่มการสร้างกิจกรรม โดยมีรายละเอียดที่จำเป็นต้องใส่ข้อมูลในส่วน General, Options และ Restrict 
access ดังนี ้

• General -> Name: ชื่อกิจกรรม Certificate หรือ ประกาศนียบัตร 

• General -> Description: รายละเอียดกิจกรรม Certificate หรือ ประกาศนียบัตร 
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• Options -> Delivery options: การกำหนดตัวเลือกการนำส่งประกาศนียบัตรจากระบบ มี 2 
รูปแบบ ได้แก่ 1) การแสดงใบประกาศนียบัตรเป็นไฟล์ PDF ในเบราว์เซอร์โดยตรง ซึ่งผู้เรียนสามารถดูไฟล์ 
PDF ได้ก ่อนที ่จะเลือกดาวน์โหลดเอง (Send the file inline to the browser) และ2) การกำหนดให้      
ดาวน์โหลดไฟล์ PDF ทันทีโดยไม่แสดงในเบราว์เซอร์ (Send to the browser and force a file download) 

• Options -> Email students: ระบบจะส่งใบประกาศนียบัตรในรูปแบบไฟล์ PDF ไปยังอีเมลของ
ผู้เรียนโดยอัตโนมัติ เมื่อผู้เรียนได้ทำตามเงื่อนไขที่กำหนดและได้รับใบประกาศนียบัตร 

• Options -> Allow anyone to verify a certificate: เปิดให้บุคคลทั่วไป (ไม่จำเป็นต้องล็อกอิน) 
สามารถตรวจสอบความถูกต้องของใบประกาศนียบัตรที ่ออกให้กับผู ้ เร ียนได้ โดยใช้ QR Code หรือ 
Verification URL ที่แนบมาในใบประกาศนียบัตร 

• Options -> Set protection: การกำหนดสิทธิ์ในการปกป้องใบประกาศนียบัตร PDF ที่ออกให้กับ
ผู้เรียน เพื ่อความปลอดภัย โดยสามารถเลือกได้ 3 แบบ ได้แก่ 1) Print: ป้องกันไม่ให้ผู ้เรียน พิมพ์ ใบ
ประกาศนียบัตร 2) Modify: ป้องกันไม่ให้ผู้เรียน แก้ไข เนื้อหาภายในใบประกาศนียบัตร 3) Copy: ป้องกัน
ไม่ให้ผู้เรียน คัดลอก ข้อมูลในใบประกาศนียบัตร 

• Restrict access -> Access restrictions: การกำหนดเง ื ่ อนไขการ เข ้ าถ ึ งก ิ จกรรมร ั บ ใ บ
ประกาศนียบัตร (Certificate) เช่น กำหนดให้ผ่านกิจกรรมดู Video สื่อการสอนทั้งหมด การกำหนดคะแนน
การทำแบบทดสอบแต่ละกิจกรรมต้องผ่านตามร้อยละที่กำหนด เป็นต้น 

ตัวอย่างการกำหนดคะแนนผ่านการเข้าทำกิจกรรมการทำแบบทดสอบร้อยละ 50 โดยการกำหนดนี้
ผู้เรียนจะต้องเข้าทำแบบทดสอบนี้ให้ได้คะแนนเท่ากับหรือมากกว่าร้อยละ 50 ของคะแนนเต็มกิจกรรมทำ
แบบทดสอบนั้น ดังรูป 
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เมื่อตั้งค่าต่าง ๆ เรียบร้อยแล้ว ให้ทำการ Save โดยการเลือกปุ่ม “Save and return to course” 
หรือ “Save and Display” จะแสดงผลในหน้าคอร์ส ดังรูป 

 

 
 

ขั้นตอนที่ 2 การตั้งค่าส่วนประกอบของ “ประกาศนียบัตร (Certificate)” โดยการคลิกเข้ากิจกรรมให้
เลือก แทบ็ “Edit certificate” เพื่อทำการปรับแต่งส่วนประกอบของประกาศนียบัตร ดังรูป 
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เมื่อทำการเลือก "Edit certificate" ใน Custom Certificate จะปรากฏหน้าต่างที่สามารถแก้ไข หรือ 
ปรับแต่งใบประกาศนียบัตร ได้ ซึ่งจะมีหัวข้อที่ต้องกำหนดค่า ดังนี้  

• ประกาศนียบัตร -> Name: ชื่อประกาศนียบัตร 

• ประกาศนียบัตร -> Width (ความกว้าง): กำหนดความกว้างของใบประกาศนียบัตร กำหนดเลข 
297 

• ประกาศนียบัตร -> Height (ความสูง): กำหนดความสูงของใบประกาศนียบัตร กำหนดเลข 210 

• ประกาศนียบัตร -> Left margin: ระยะห่างจากขอบซ้าย กำหนดเลข 0 

• ประกาศนียบัตร -> Right margin: ระยะห่างจากขอบขวา กำหนดเลข 0 

• ประกาศนียบัตร -> Elements: เลือก “Background image” กดปุ่ม “Add element” จะ
ปรากฏหน้าต่างการเพ่ิมภาพพ้ืนหลังสำหรับ ประกาศนียบัตร โดยให้ทำการ “Upload image” ที่เตรียมไว้
เป็นพื้นหลังประกาศนียบัตร ทำการ “Save  Continue” สังเกตในช่อง “Image” ให้เปลี่ยนมาเลือกภาพที่ได้
ทำการ “Upload image” ไว้ และกด “Save changes” ดังรูป 
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• ประกาศนียบัตร -> Elements: เลือก “Student Name” กดปุ่ม “Add element” จะปรากฏ
หน้าต่างการเพิ่มชื่อผู้เรียน โดยสามารถปรับแต่ง Font, Size, Colour ได้ เมื่อปรับแต่ง Font เรียบร้อยให้ทำ
การ กด “Save  Change” 
 
 

 
 
 
 

        
 

• ประกาศนียบัตร -> Elements: เลือก “Date” กดปุ่ม “Add element” จะปรากฏหน้าต่างการเพ่ิม
ชื่อผู้เรียน โดยสามารถปรับแต่ง “Date item”, “Date format” ที่เหมาะสม รวมถึงการปรับแต่ง 
Font, Size, Colour ได้ เมื่อปรับแต่งตามต้องการเรียบร้อยแล้วให้ทำการ กดปุ่ม “Save  Change” 
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• ประกาศนียบัตร -> Reposition elements: เมื่อเพิ่มองค์ประกอบการทำประกาศนียบัตรครบให้
เลือก “Reposition elements” เพื่อทำการจัดวางองค์ประกอบให้เหมาะสม เมื่อได้ตำแหน่งที่เหมาะสมให้
เลือกปุ่ม “Save and close” และเมื่อกลับสู่หน้าตั้งค่าประกาศนียบัตรหลักแล้วให้ทำการกดปุ่ม “Save  
Change” และ/หรือต้องการดูตัวอย่างประกาศนียบัตรที่ได้ตั ้งค่าไว้ให้เลือก กดปุ่ม “Save  Change and 
preview” ดังรูป 

 
 

 
 

 

วันดี สีสวย 
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3. การสรา้งแบบทดสอบบนระบบ SUT iLearn 
  

แบบทดสอบเป็นกิจกรรมการเรียนที่ผู้สอนสามารถสร้างชุดคำถามขึ้นมาเพ่ือวัดผลการเรียนรู้ในคอร์ส 
โดยผู ้เรียนสามารถเข้าทำแบบทดสอบออนไลน์ในคอร์ส และทราบคะแนนที่ได้จากการทำแบบทดสอบ 
ขั้นตอนการสร้างแบบทดสอบ ดังนี้ 
 
3.1 การสรา้งหมวดหมูเ่ก็บค าถาม 
 หมวดหมู่คำถามเป็นหมวดหมู่สำหรับเก็บข้อคำถามของรายวิชา ซึ่งผู้สอนสามารถสร้างหมวดหมู่
คำถามเป็นหมวดหมู่ย่อย ๆ เพื่อสะดวกในการนำไปใช้กับแบบทดสอบในแต่ละชุด และสามารถจัดการกับ
หมวดหมู่คำถามและข้อคำถามในรายวิชา  

สร้างหมวดหมู่คำถามโดยเลือกเมนู Question bank ที่แท็บ More หน้าแรกของคอร์ส 

 
    

เลือกเมนู ประเภท 
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เลือกเมนู เพิ่มประเภท เพื่อสร้างหมวดหมู่คำถามใหม่สำหรับเก็บข้อคำถาม ถ้าในคอร์สไม่มีการสร้าง
หมวดหมู่คำถามขึ้นมาใหม่ ข้อคำถามที่สร้างขึ้นจะถูกเก็บไว้ในหมวดหมู่คำถามเริ่มต้นของคอร์สซึ่งในคอร์สนี้
คือ Default for Demo Course 

 
 

กรอกชื่อของหมวดหมู่คำถามที่สร้างใหม่ โดยหมวดหมู่คำถามใหม่จะอยู่ภายใต้หมวดหมู่เริ่มต้นของ
คอร์ส (Default for Demo Course) ตัวอย่าง ตั้งชื ่อหมวดหมู่คำถามเป็น คำถามชุดที่ 1 โดยสามารถใส่
รายละเอียดของหมวดหมู่คำถามเพ่ือเป็นข้อมูลเกี่ยวข้อคำถามที่เก็บในหมวดหมู่คำถามนี้ 

 
  

ตัวอย่าง สร้างหมวดหมู่คำถามไว้ 2 หมวดหมู่ ได้แก่ คำถามชุดที่ 1 และ คำถามชุดที่ 2 อยู่ภายใต้
หมวดหมู่เริ่มต้นของคอร์ส Default for Demo Course ส่วนท้ายของหมวดหมู่คำถามแสดงจำนวนข้อคำถาม
ในหมวดหมู่เป็นตัวเลขภายในวงเล็บ 
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3.2 การสรา้งค าถาม 
 ผู้สอนสามารถสร้างคำถามทีละข้อ หรือสร้างคำถามทีละหลายข้อพร้อมกันโดยการนำเข้าจากไฟล์ 
Text และจัดเก็บไว้ในหมวดหมู่คำถามเพ่ือนำไปใช้กับแบบทดสอบ 

 
3.2.1 การสร้างคำถามทีละ 1 ข้อ 

 
 

 เลือกเมนู คำถาม เข้าสู่หน้าคำถามของคอร์ส 

 
 

 เลือกเมนู สร้างคำถามใหม่ 
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 แสดงหน้าต่างให้เลือกประเภทคำถามที่ต้องการ โดยเป็นการสร้างทีละคำถาม ตัวอย่าง เลือกคำถาม
แบบปรนัย แล้วคลิกปุ่ม เพ่ิม เพ่ือเข้าไปสร้างคำถาม 

 
 

 
 
 กำหนดรายละเอียดให้คำถาม 

- ประเภท เลือกหมวดหมู่ที่ต้องการเก็บคำถาม 
- ชื่อคำถาม เป็นข้อมูลเกี่ยวกับคำถามข้อนี้ (ผู้เรียนจะไม่เห็นในส่วนนี้) 
- รายละเอียดคำถาม เป็นคำถามหรือโจทก์ที่จะถามผู้เรียนในข้อนี้ 
- Default mark กำหนดคะแนนของคำถามข้อนี้ 
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 กำหนดคำตอบให้กับคำถาม โดยใส่ข้อมูลลงในคำตอบตามจำนวนตัวเลือกที่ต้องการ ซึ่งตัวเลือกใด
ถูกต้อง ให้เลือกคะแนนที่ได้เป็น 100% โดยกำหนดให้ตัวเลือกที่ไม่ถูกต้องเป็น ไม่มี 

คำถามที่สร้างจะถูกเก็บในหมวดหมู่ของคอร์ส ผู้สอนสามารถเข้าไปจัดการคำถามได้ เช่น เปิดคำถาม
เพ่ือแสดงตัวอย่าง ลบ แก้ไข และทำซ้ำ เป็นต้น 

 
  

แสดงตัวอย่างคำถาม และตรวจสอบเฉลยว่าถูกต้องหรือไม่โดยการเลือกตัวเลือก และคลิกปุ่มส่ง และ
เสร็จสิ้น 

 
 

 ระบบจะแสดงคำตอบว่าตัวเลือกที่เลือก ถูกหรือผิด 
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 3.2.2 การสร้างคำถามโดยนำเข้าไฟล์ Text 
 ผู้สอนสามารถสร้างคำถามเพื่อเก็บไว้ในคอร์สทีละหลายข้อในครั้งเดียวโดยการนำเข้าไฟล์ Text ซึ่ง
จะต้องทำการจัดรูปแบบคำถามในเอกสารให้อยู่ในรูปแบบ Aiken และบันทึกไฟล์ให้มีนามสกุลเป็น .txt 
ตัวอย่างการจัดรูปแบบคำถามดังรูปด้านล่าง 
 

 
 
 การจัดรูปแบบคำถามแบบปรนัยมีข้อกำหนด ดังนี้ 

- คำถามต้องอยู่ในบรรทัดเดียวกัน คำถามยาว ๆ ไม่ Enter ขึ้นบรรทัดใหม ่
- จะมีเลขข้อคำถามหรือไม่มีก็ได้ แต่ถ้ามีเลขข้อจะไม่เหมาะกับการนำไปใช้ในการสลับข้อคำถาม 

เนื่องจากมีเลขข้อติดไปด้วย เลขข้อจะไม่ตรงกับลำดับข้อเวลาแสดงผล 
- กำหนดตัวเลือกได้ตั้งแต่ 2 ตัวเลือกขึ้นไป หน้าตัวเลือกให้กำหนดเป็น A. B. C. หรือ A) B) C) 

ตามลำดับ 
- คำตอบที่ถูกต้องให้กำหนดเป็น ANSER: ตามด้วยตัวเลือกที่ถูกต้อง เช่น ANSER: B 
- คำถามแต่ละข้อจะเว้นด้วยการขึ้นบรรทัดใหม่ โดยไม่จำเป็นต้องเว้นช่องว่างระหว่างบรรทัด 
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 ขั้นตอนการนำเข้าไฟล์คำถาม ดังนี้ 
เลือกเมนู ประเภท เข้าไปแสดงหมวดหมู่ที่เก็บคำถามของคอร์ส 

 
 
เลือกหมวดหมู่ที่ต้องการเก็บคำถามจากไฟล์ Text ที่นำเข้า ตัวอย่าง เลือกหมวดหมู่ คำถามชุดที่ 2 

 
  

เลือกเมนู นำเข้า เพ่ือไปยังหน้าอัปโหลดไฟล์ Text 
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เลือก File format เป็น Aiken format แล้วอัปโหลดไฟล์คำถาม คลิกปุ่ม นำเข้า 

 
 

 แสดงหน้าการนำเข้าคำถามเรียบร้อย คลิกปุ่ม Continue กลับไปหน้า Question bank 

 
  

แสดงคำถามท้ังหมดที่นำเข้าในหมวดหมู่คำถามชุดที่ 2 
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 3.3 การสรา้งแบบทดสอบ 
3.3.1 การสร้างแบบทดสอบและใส่คำชี้แจง  
หน้าแรกของคอร์สเลือกเมนู เพิ่มกิจกรรมหรือแหล่งข้อมูล 

 
   

เลือกกิจกรรม แบบทดสอบ 

 
 

 กรอกรายละเอียดของแบบทดสอบ และบันทึก  
- ชื่อ เป็นข้อความที่ลิงก์เข้าทำแบบทดสอบ 
- คำนำ เป็นคำชี้แจงหรือรายละเอียดการทำแบบทดสอบที่แจ้งผู้เรียน 
- แสดงคำอธิบายในหน้ารายวิชา เป็นการกำหนดให้แสดงข้อมูลส่วนของคำนำแสดงให้ผู้เรียน

เห็นภายใต้ชื่อแบบทดสอบ 
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3.3.2 การตั้งค่าแบบทดสอบ 
หน้าแรกของคอร์สเลือกแบบทดสอบ และคลิกแท็บ การตั้งค่า 

 
  

- กำหนดเวลา เป็นการกำหนดช่วงวันเวลาที่ให้เข้าทำแบบทดสอบ 

 
 ตัวอย่าง กำหนดให้เริ่มเข้าทำได้ตั้งแต่วันที่ 17 มีนาคม 2568 เวลา 8.30 น. เป็นต้นไป ไม่มีกำหนดปิด
แบบทดสอบ โดยจับเวลาทำแบบทดสอบ 10 นาที 
 

- คะแนนที่ได้ กำหนดการให้คะแนน และจำนวนครั้งที่ให้ทำแบบทดสอบ 

 
 ตัวอย่าง กำหนดให้ทำแบบทดสอบได้ 2 ครั้ง โดยระบบจะเลือกคะแนนสูงสุดที่ทำได้ 
 

- รูปแบบ กำหนดจำนวนข้อคำถามท่ีแสดงในแต่ละหน้า 

 
 ตัวอย่าง กำหนดให้แสดงหน้าละ 1 คำถาม โดยสามารถย้อนกลับมาทำข้อไหนก่อนก็ได้  
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- การกระทำของคำถาม กำหนดการสลับตัวเลือก 

 
ตัวอย่าง กำหนดให้สลับตัวเลือกในแต่ละคำถาม 

 
- Review options กำหนดการแสดงเฉลย ความเห็น คะแนน และ อ่ืน ๆ ตามช่วงเวลาของการ

ทำแบบทดสอบ 

 
 ตัวอย่าง กำหนดให้แสดงคะแนนในแต่ละข้อและคะแนนรวมที่ได้ในการทำแบบทดสอบ โดยให้แสดง
คะแนนหลังจากท่ีทำแบบทดสอบเสร็จ (หลังจากนี้ขณะที่ยังเปิดการใช้งานแบบทดสอบ) 
 
3.4 การน าค าถามใส่ในแบบทดสอบ 

เลือกแบบทดสอบในหน้าแรกของคอร์ส เพ่ือเข้าหน้าจัดการแบบทดสอบ 
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คลิกปุ่ม เพ่ิมคำถาม เพ่ือเข้าไปเลือกคำถามที่สร้างไว้ในคอร์ส 

 
  

เลือกเพ่ิมคำถามที่เมนู จากคลังคำถาม 

 
   

ตัวอย่าง เลือกคำถามในหมวดหมู่ คำถามชุดที่ 2 
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  ตัวอย่าง คลิกปุ่ม Apply filters ซึ่งมีคำถามอยู่จำนวน 3 ข้อ เลือกคำถามทั้งหมด 3 ข้อ ใส่ใน
แบบทดสอบ 

 
 

 คำถาม 3 ข้อ ถูกใส่ไปในแบบทดสอบเรียบร้อย ผู ้สอนยังสามารถเพิ ่มหรือลบคำถามออกจาก
แบบทดสอบชุดนี้  กำหนดคะแนนเต็ม คะแนนแต่ละข้อ และสลับคำถามของแบบทดสอบชุดนี้ เมื่อกำหนด
แล้วทำการบันทึกข้อมูล 
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3.5 การดูตัวอย่างแบบทดสอบ 
ผู้สอนดูตัวอย่างการแสดงผลของแบบทดสอบโดยเลือกเมนู Preview quiz ที่แท็บแบบทดสอบ 

 
  

คลิกปุ่ม Start attempt เพ่ือแสดงผลแบบทดสอบ 

 
  

แสดงแบบทดสอบหน้าละข้อ และมีการจับเวลาในการทำแบบทดสอบตามที่ได้ตั้งค่าไว้ 
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3.6 การดูผลคะแนนแบบทดสอบ 
 

 เลือกแท็บ คะแนนทั้งหมด เพ่ือเข้าดูคะแนนแบบทดสอบในคอร์ส 

 
 

แสดงคะแนนของผู้เรียนทุกคนที่ได้จากการทำแบบทดสอบในแต่ละชุด และคะแนนเฉลี่ยในการทำ
แบบทดสอบของผู้เรียน 

 
  

ผู้สอนสามารถดาวน์โหลดคะแนนในรูปแบบของไฟล์ Excel เพ่ือนำไปใช้ต่อไป 
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 การเข้าดูคะแนนแบบทดสอบของชุดที่ต้องการโดยการเลือกแบบทดสอบในหน้าคอร์ส  

 
 

เลือกเมนู Attempts: 2 เป็นการเข้าดูคะแนนของผู้เรียนที่ทำแบบทดสอบ เลข 2 คือ จำนวนผู้เรียน
ที่ทำแบบทดสอบแล้ว 

 
 

แสดงข้อมูลการทำแบบทดสอบโดยละเอียด เช่น คะแนนเต็ม ข้อที่ถูกหรือผิด เวลาในการทำ แผนภูมิ
แสดงช่วงคะแนน และการดาวน์โหลดไฟล์คะแนน เป็นต้น

 


